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Supported Software and Instruments 
 
 

Software Notes 

Live This Program is designed to be used with Ableton Live. (MAX25 comes with Ableton Live Lite Akai 
Edition.) 

Reason 

For use with Propellerhead Reason. This Program supports the Reason Remote protocol with supplied 
codec files, which you may need to install. Each module in Reason will automatically map itself to 
MAX25's controllers. This allows you to use a single MAX25 preset to control all of the modules in 
Reason. 

Cubase For use with Steinberg Cubase. 

Logic Pro For use with Apple Logic Pro. 

FL Studio For use with Image-Line FL Studio. 

Pro Tools For use with Pro Tools. 

GM Drums A General MIDI drum and controller program, ideal for general drum use. 

Chrmatic A general program in which MAX25's pads use a chromatic scale. 

Ignite For use with Ignite software by AIR Music Technology. See the included card for your free download! 

PTEX For use with Pro Tools Express, available for free with many Akai Professional products. 

SONiVOX A general Program for use with all SONiVOX virtual instruments. For information on their products, 
please visit www.sonivoxmi.com. 

Air A general Program preset for use with all AIR virtual instruments. For information on their products, 
please visit www.airmusictech.com. 

Wobble For use with Wobble, a dubstep and grime synth by SONiVOX. 

Eighty8 For use with Eighty Eight, a grand piano virtual instrument by SONiVOX. 

Big Bang For use with Big Bang Cinematic Percussion, by SONiVOX. 

Vocalizr For use with Vocalizer and Vocalizer Pro, vocal manipulation effects and instruments by SONiVOX. 

Loom For use with Loom, a virtual additive synth by AIR Music Technology. 

VacumPro For use with Vacuum Pro, a virtual tube synthesizer by AIR Music Technology. 

Generic User Programs – for your own use! 

 
The included Programs are intended to be a starting point. You can easily edit and store your own 
Programs (see the Edit Mode section of the included MAX25 User Guide). The software mentioned 
in this manual allows incredible amounts of control with MAX25. By using multiple MIDI channels, 
controllers, pad modes, and program changes, you can easily create some incredible music. 
 
Enjoy! 
 
The Akai Professional Team 



 

3 

 

Ableton Live 
 

Setup 
 
To install and use the Live controller map, follow these instructions:  
 
1. Download the Live controller map to your computer from the included CD or from 

www.akaipro.com/max25. 
 

2. With Live closed, copy the entire MAX25 folder (the folder itself, not just its contents) to the 
following location in your computer:  

 
Windows 7 or Windows Vista: 
C:\Users\[YourUserName]\AppData\Roaming\Ableton\Live [VersionNumber]\Preferences\User 
Remote Scripts 

Note: The AppData folder is a hidden folder. To make this folder visible: 
1. On your PC, open Computer. 
2. Select the Organize menu at the top of the window, and choose Folder and search 

options. 
3. In the window that opens, select the View tab. 
4. Scroll down, locate, and select Show hidden files and folders. 
5. Click Apply, then OK. 

 
Windows XP: 
C:\Documents and Settings\[YourUserName]\Application Data\Ableton\ 
Live [VersionNumber]\Preferences\User Remote Scripts 

Note: The Application Data folder is a hidden folder. To make this folder visible: 
1. On your PC, open My Computer. 
2. Select the Tools menu at the top of the screen, and choose Folder Options. 
3. In the window that opens, select the View tab. 
4. Scroll down, locate, and select Show hidden files and folders. 
5. Click Apply, then OK. 

 
Mac OS X: 
Macintosh HD  Users  [YourUserName]  Library  Preferences  Ableton  Live 
[VersionNumber]  User Remote Scripts 

Note: In OS X 10.7 and above, the User Library is hidden by default.  To access the user 
library, hold the Option key and click on the Go menu. Select Library and navigate to 
Preferences  Ableton  Live [VersionNumber]  User Remote Scripts 

 
3. Connect MAX25 to your computer with the included USB cable. Open Live. 

 
4. On MAX25, select the Live or LiveKS Program. Press the Value Dial to load it. 

Note: If you have edited MAX25's Programs and are unable to load the Program, use the 
supplied Vyzex editor to load the Factory Preset Bank and "PUT" or download the factory 
preset bank into MAX25. 
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5. Open Live's Preferences window. 

• Windows: Options  Preferences. 

• Mac OS X: Live Menu  Preferences. 
 

6. Select the MIDI Sync tab on the left-hand side. 
 

7. Select MAX25 as the Control Surface.  

• Windows: Set the Control Surface to MAX25 and set the Input and Output to USB 
Audio Device or AKAI MAX 25 depending on your system. 

• Mac: Set the Control Surface, Input, and Output to MAX25. 

Note: In Live 8, MAX25 will be the last item in the Control Surface drop-down menu. In Live 
9, MAX25 will be shown in an alphabetical list. 

 
8. Under MIDI Ports, next to Input, set the Track and Remote settings to On. This allows Live to 

accept Track and Remote MIDI from MAX25. 
 

9. To allow Live to synchronize your faders for 1 to 1 control, select Remote next to Output. 
 

10. If you would like the MAX25 to sync to Live's MIDI clock, next to Output select Sync.  Be sure 
the MAX25's Source setting in the Global > Clock menu is set to External. 
 

11. Close the Preferences window. 
 

Program Operation 
 
Live 
 
When using MAX25's Live Program, the controls' behavior is as follows: 
 
Transport Controls (Play, Stop, Rec, etc.): These controls are set to MIDI CC, so they will work 
accordingly in the software. 
 
Bank 1-4:  

• Touch faders: These control the volume level of Tracks 1-4. 

• S-switches: These record-arm Tracks 1-4. 
 
Bank 5-8:  

• Touch faders: These control the volume level of Tracks 5-8. 

• S-switches: These record-arm Tracks 5-8. 
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Bank 9-12:  

• Touch faders:  These will control the top row of any device bank selected by the "blue hand". 

• S-switches: Switch 1 will select the previous bank of controls. Switch 2 will select the next 
bank of controls. Switch 4 will lock the control surface to the currently selected device.  

 
Bank 13-16:  

• Touch faders:  These will control the bottom row of any device bank selected by the "blue 
hand". 

• S-switches: Switch 1 will select the previous bank of controls. Switch 2 will select the next 
bank of controls. Switch 4 will lock the control surface to the currently selected device.  

 
Pad Bank A: These pads act as the bottom 8 pads of the currently selected pad bank in Drum Rack. 
 
Pad Bank B: These pads act as the top 8 pads of the currently selected pad bank in Drum Rack. 
 
Notes:  

• [SEQ CC] is set to MIDI CC #74, so MAX25 will send CC #74 anytime its Sequencer is on. 
You can change the CC# in Edit Mode. See the Edit Mode section of the included MAX25 
User Guide. 

• Controls not mentioned in this mapping are not assigned and can be mapped as you prefer. 
 
LiveKS 
 
This Program is almost the same as the Live Program described above, but this version allows you to 
turn MAX25's Sequencer on/off by pressing keys on its keyboard. To do this: 
 
1. Press SEQ SELECT so it is lit. 

2. Press ON/OFF so it is lit. 

3. Press and hold a key on MAX25's keyboard. The Sequence will play (in that key) while the key 
is being held. When you release the key, the Sequence will stop.  

Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, 
Sequencer playback will continue even after the key is released.) 

 
 



 

6 

 

Propellerhead Reason 
 
Reason allows for vast control of its parameters. Propellerhead Software has developed a way to 
remap a single control surface to each of the modules in Reason. This protocol is called Reason 
Remote. We have included all the files necessary to enable Reason to find MAX25 and map its 
controls to whatever module you have selected in the sequencer. 
 

Setup 
 
1. Install the MAX25 Reason preset file.  

 
Note: You must have the following version of Reason: 

• Windows 7, Windows Vista, or Windows XP: Version 3.0.4 (or later)  

• Mac OS X: Version 3.0.5 (or later) 
 

Windows 7 and Windows Vista: 
1. Double-click the Computer icon on the desktop, then double-click Local Disk (C:). 
2. Towards the upper-left of the window, select the Organize menu, and choose Folder and 

Search Options. 
3. At the top of the window that opens, select the View tab. 
4. In the list titled Advanced settings, double-click the Show hidden files and folders 

option. 
5. Click Apply, then click OK. The Folder Options window will close. 
6. The Akai Reason Remote Files folder (on the included CD) contains two folders: Lua 

Codecs and Maps. Open the Lua Codecs folder. 
7. Copy the folder titled Akai into the following directory on your computer: C:\Program 

Data\Propellerhead Software\Remote\Codecs\Lua Codecs. 
8. Next, in the Akai Reason Remote Files folder, open the folder titled Maps 
9. Copy the AkaiMAX25_100 file to the following directory on your computer: C:\Program 

Data\Propellerhead Software\Remote\Maps. 
10. Connect MAX25 to your computer with the included USB cable. 
11. Open Reason and select the Edit menu from the top of the screen, and open Preferences. 
12. Using the pull-down menu at the top of the Preferences window, choose Control 

Surfaces And Keyboards. 
13. Click the Add button. 
14. Select Akai from the Manufacturer list. 
15. Select MAX25 from the Model list. 
16. Set the In Port to Akai MAX25 Port 1. 
17. Set the Out Port to Akai MAX25 Port 1. 
18. Click Ok and then close the Preferences window.  
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Windows XP: 
1. The Akai Reason Remote Files folder (on the included CD) contains two folders: Lua 

Codecs and Maps. Open the Lua Codecs folder. 
2. Copy the folder titled Akai into the following directory on your computer: C:\Documents 

and settings\All Users\Application Data\Propellerhead Software\Remote\Codecs\Lua 
Codecs. 

3. Next, in the Akai Reason Remote Files folder, open the folder titled Maps. 
4. Copy the AkaiMAX25_100 file to the following directory on your computer: C:\Documents 

and settings\All Users\Application Data\Propellerhead Software\Remote\Maps. 
5. Connect MAX25 to your computer with the included USB cable. 
6. Open Reason and select the Edit menu from the top of the screen, and open Preferences. 
7. Using the pull-down menu at the top of the Preferences window, choose Control 

Surfaces And Keyboards. 
8. Click the Add button. 
9. Select Akai from the Manufacturer list. 
10. Select MAX25 from the Model list. 
11. Set the In Port to USB Audio Device. 
12. Set the Out Port to USB Audio Device. 
13. Click Ok and then close the Preferences window.  

 
Mac OS X: 
1. The Akai Reason Remote Files folder (the same folder where you found this guide) 

contains two folders: Lua Codecs and Maps. Open the Lua Codecs folder.  
2. Copy the folder titled Akai into the following directory on your computer: Macintosh 

HD\Library\Application Support\Propellerhead Software\Remote\CODECS\LUA 
CODECS.  

3. Next, in the Akai Reason Remote Files folder, open the folder titled Maps.  
4. Copy the AkaiMAX25_100 folder to the following directory on your computer: Macintosh 

HD\Library\Application Support\Propellerhead Software\Remote\Maps.  
5. Connect MAX25 to your computer with the included USB cable. 
6. Open Reason and select the Edit menu from the top of the screen, and open Preferences.  
7. Using the pull-down menu at the top of the Preferences window, choose Control Surfaces 

And Keyboards.  
8. Click the Add button.  
9. Select Akai from the Manufacturer list.  
10. Select MAX25 from the Model list. 
11. Set the In Port to Akai MAX25 Port 1.  
12. Set the Out Port to Akai MAX25 Port 1.  
13. Click Ok and then close the Preferences window.  

 
2. On MAX25, select the Reason or ReasonKS Program. Press the Value Dial to load it. 

Note: If you have edited MAX25's Programs and are unable to load the Program, use the supplied 
Vyzex editor to load the Factory Preset Bank and "PUT" or download the factory preset bank into 
MAX25. 
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Program Operation 
 
Reason 
 
To see how the MAX25 controls are mapped to each module in Reason, please refer to the tables on 
the following pages. 
 
You can always change how controllers are mapped by modifying the AkaiMAX25_100.remotemap 
file. This will allow you to customize how Reason and your MAX25 work. 
 
ReasonKS 
 
This Program is almost the same as the Reason Program described above, but this version allows 
you to turn MAX25's Sequencer on/off by pressing keys on its keyboard. To do this: 
 
1. Press SEQ SELECT so it is lit. 

2. Press ON/OFF so it is lit. 

3. Press and hold a key on MAX25's keyboard. The Sequence will play (in that key) while the key is 
being held. When you release the key, the Sequence will stop.  

Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, 
Sequencer playback will continue even after the key is released.) 
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Reason/MAX25 Mappings 

 
Mixer 6:2 
 

 
 
 
 
 

 

Combinator 
 

 
 

Global Controls Master Keyboard 

MAX25 Control Reason Function  MAX25 Control Reason Function
Stop Stop  Keyboard Keyboard 
Play Play  Pitch Bend Pitch Bend 

Record Record  Mod Wheel Mod Wheel 
Switch 3 Device Select Up  Expression Expression 
Switch 4 Device Select Down 

 Switch 7 Program Down 
Switch 8 Program Up 

MAX25 Control Reason Function  MAX25 Control Reason Function 
Fader 1 Channel 1 Level  Switch 1 Channel 1 Mute 
Fader 2 Channel 2 Level  Switch 2 Channel 2 Mute 
Fader 3 Channel 3 Level  Switch 3 Channel 3 Mute 
Fader 4 Channel 4 Level  Switch 4 Channel 4 Mute 
    
Fader 5 Channel 1 Pan  Switch 9 Channel 1 Solo 
Fader 6 Channel 2 Pan  Switch 10 Channel 2 Solo 
Fader 7 Channel 3 Pan  Switch 11 Channel 3 Solo 
Fader 8 Channel 4 Pan  Switch 12 Channel 4 Solo 
    
Fader 9 Channel 1 Aux Send   
Fader 10 Channel 2 Aux Send   
Fader 11  Channel 3 Aux Send   
Fader 12 Channel 4 Aux Send   
  
Fader 13 Master Level 
Fader 14 Aux Return 
Fader 15  
Fader 16  

MAX25 Control Reason Function  MAX25 Control Reason Function 
Fader 1 Rotary 1  Switch 1 Button 1 
Fader 2 Rotary 2  Switch 2 Button 2 
Fader 3 Rotary 3  Switch 3 Button 3 
Fader 4 Rotary 4  Switch 4 Button 4 
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Mixer 14:2 
 
Group 1: 
 

 
Group 2: 
 

MAX25 
Control 

Reason 
Function 

Control  
Variations  MAX25 

Control 
Reason
Function 

Control
Variations 

Fader 1 Channel 1 Level Levels Pan Mutes1 1-7  Switch 1 Channel 1 Mute Levels Pan Mutes1 1-7 
Fader 2 Channel 2 Level Levels Pan Mutes1 1-7  Switch 2 Channel 2 Mute Levels Pan Mutes1 1-7 
Fader 3 Channel 3 Level Levels Pan Mutes1 1-7  Switch 3 Channel 3 Mute Levels Pan Mutes1 1-7 
Fader 4 Channel 4 Level Levels Pan Mutes1 1-7  Switch 4 Channel 4 Mute Levels Pan Mutes1 1-7 
      
Fader 5 Channel 5 Level Levels Pan Mutes1 1-7  Switch 9 Channel 5 Mute Levels Pan Mutes1 1-7 
Fader 6 Channel 6 Level Levels Pan Mutes1 1-7  Switch 10 Channel 6 Mute Levels Pan Mutes1 1-7 
Fader 7 Channel 7 Level Levels Pan Mutes1 1-7  Switch 11 Channel 7 Mute Levels Pan Mutes1 1-7 
Fader 8 Master Level Master Level  Switch 12   
      
Fader 9 Channel 1 Pan Levels Pan Mutes1 1-7    
Fader 10 Channel 2 Pan Levels Pan Mutes1 1-7    
Fader 11  Channel 3 Pan Levels Pan Mutes1 1-7    
Fader 12 Channel 4 Pan Levels Pan Mutes1 1-7    
      
Fader 13 Channel 5 Pan Levels Pan Mutes1 1-7    
Fader 14 Channel 6 Pan Levels Pan Mutes1 1-7    
Fader 15  Channel 7 Pan Levels Pan Mutes1 1-7    
Fader 16      

MAX25 
Control 

Reason 
Function 

Control 
Variations 

 MAX25 
Control 

Reason 
Function 

Control
Variations 

Fader 1 Channel 1 Level Levels Sends Mutes1 1-7  Switch 1 Channel 1 Mute Levels Sends Mutes1 1-7 
Fader 2 Channel 2 Level Levels Sends Mutes1 1-7  Switch 2 Channel 2 Mute Levels Sends Mutes1 1-7 
Fader 3 Channel 3 Level Levels Sends Mutes1 1-7  Switch 3 Channel 3 Mute Levels Sends Mutes1 1-7 
Fader 4 Channel 4 Level Levels Sends Mutes1 1-7  Switch 4 Channel 4 Mute Levels Sends Mutee1 1-7 
      
Fader 5 Channel 5 Level Levels Sends Mutes1 1-7  Switch 9 Channel 5 Mute Levels Sends Mutes1 1-7 
Fader 6 Channel 6 Level Levels Sends Mutes1 1-7  Switch 10 Channel 6 Mute Levels Sends Mutes1 1-7 
Fader 7 Channel 7 Level Levels Sends Mutes1 1-7  Switch 11 Channel 7 Mute Levels Sends Mutes1 1-7 
Fader 8    Switch 12   
      
Fader 9 Channel 1 Aux 1 Send Levels Sends Mutes1 1-7    
Fader 10 Channel 2 Aux 1 Send Levels Sends Mutes1 1-7    
Fader 11  Channel 3 Aux 1 Send Levels Sends Mutes1 1-7    
Fader 12 Channel 4 Aux 1 Send Levels Sends Mutes1 1-7    
      
Fader 13 Channel 5 Aux 1 Send Levels Sends Mutes1 1-7    
Fader 14 Channel 6 Aux 1 Send Levels Sends Mutes1 1-7    
Fader 15  Channel 7 Aux 1 Send Levels Sends Mutes1 1-7    
Fader 16      
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Mixer 14:2 (continued) 
 
Group 3: 
 
MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason 
Function 

Control
Variations 

Fader 1 Channel 1 Level Levels Sends Mutes2 1-7  Switch 1 Channel 1 Mute Levels Sends Mutes2 1-7 
Fader 2 Channel 2 Level Levels Sends Mutes2 1-7  Switch 2 Channel 2 Mute Levels Sends Mutes2 1-7 
Fader 3 Channel 3 Level Levels Sends Mutes2 1-7  Switch 3 Channel 3 Mute Levels Sends Mutes2 1-7 
Fader 4 Channel 4 Level Levels Sends Mutes2 1-7  Switch 4 Channel 4 Mute Levels Sends Mutes2 1-7 
      
Fader 5 Channel 5 Level Levels Sends Mutes2 1-7  Switch 5 Channel 5 Mute Levels Sends Mutes2 1-7 
Fader 6 Channel 6 Level Levels Sends Mutes2 1-7  Switch 6 Channel 6 Mute Levels Sends Mutes2 1-7 
Fader 7 Channel 7 Level Levels Sends Mutes2 1-7  Switch 7 Channel 7 Mute Levels Sends Mutes2 1-7 
Fader 8    Switch 8   
   
Fader 9 Channel 1 Aux 2 Send Levels Sends Mutes2 1-7    
Fader 10 Channel 2 Aux 2 Send Levels Sends Mutes2 1-7    
Fader 11  Channel 3 Aux 2 Send Levels Sends Mutes2 1-7    
Fader 12 Channel 4 Aux 2 Send Levels Sends Mutes2 1-7    
     
Fader 13 Channel 5 Aux 2 Send Levels Sends Mutes2 1-7    
Fader 14 Channel 6 Aux 2 Send Levels Sends Mutes2 1-7    
Fader 15  Channel 7 Aux 2 Send Levels Sends Mutes2 1-7    
Fader 16      
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Mixer 14:2 (continued) 
 
Group 4: 
 

 

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason 
Function 

Control
Variations 

Fader 1 Channel 1 Level Levels Sends Mutes3 1-7  Switch 1 Channel 1 Mute Levels Sends Mutes3 1-7 
Fader 2 Channel 2 Level Levels Sends Mutes3 1-7  Switch 2 Channel 2 Mute Levels Sends Mutes3 1-7 
Fader 3 Channel 3 Level Levels Sends Mutes3 1-7  Switch 3 Channel 3 Mute Levels Sends Mutes3 1-7 
Fader 4 Channel 4 Level Levels Sends Mutes3 1-7  Switch 4 Channel 4 Mute Levels Sends Mutes3 1-7 
Fader 5 Channel 5 Level Levels Sends Mutes3 1-7  Switch 5 Channel 5 Mute Levels Sends Mutes3 1-7 
Fader 6  Channel 6 Level Levels Sends Mutes3 1-7  Switch 6 Channel 6 Mute Levels Sends Mutes3 1-7 
Fader 7 Channel 7 Level Levels Sends Mutes3 1-7  Switch 7 Channel 7 Mute Levels Sends Mutes3 1-7  
Fader 8    Switch 8   
      
Fader 9 Channel 8 Level Levels Sends Mutes3 1-7    
Fader 10 Channel 9 Level Levels Sends Mutes3 1-7    
Fader 11 Channel 10 Level Levels Sends Mutes3 1-7    
Fader 12 Channel 11 Level Levels Sends Mutes3 1-7    
Fader 13 Channel 12 Level Levels Sends Mutes3 1-7    
Fader 14 Channel 13 Level Levels Sends Mutes3 1-7    
Fader 15 Channel 14 Level Levels Sends Mutes3 1-7    
Fader 16      
      
Fader 17 Channel 1 Aux 3 Send Levels Sends Mutes3 1-7    
Fader 18 Channel 2 Aux 3 Send Levels Sends Mutes3 1-7    
Fader 19  Channel 3 Aux 3 Send Levels Sends Mutes3 1-7    
Fader 20 Channel 4 Aux 3 Send Levels Sends Mutes3 1-7    
Fader 21 Channel 5 Aux 3 Send Levels Sends Mutes3 1-7    
Fader 22 Channel 6 Aux 3 Send Levels Sends Mutes3 1-7    
Fader 23 Channel 7 Aux 3 Send Levels Sends Mutes3 1-7    
Fader 24      
      
Fader 25 Channel 8 Aux 3 Send Levels Sends Mutes3 1-14    
Fader 26 Channel 9 Aux 3 Send Levels Sends Mutes3 1-14    
Fader 27  Channel 10 Aux 3 Send Levels Sends Mutes3 1-14    
Fader 28 Channel 11 Aux 3 Send Levels Sends Mutes3 1-14    
Fader 29 Channel 12 Aux 3 Send Levels Sends Mutes3 1-14    
Fader 30 Channel 13 Aux 3 Send Levels Sends Mutes3 1-14    
Fader 31 Channel 14 Aux 3 Send Levels Sends Mutes3 1-14    
Fader 32      
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Mixer 14:2 (continued) 
 
Group 5: 
 

 
 

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason 
Function 

Control
Variations 

Fader 1 Channel 1 Level Levels Sends Mutes4 1-7  Switch 1 Channel 1 Mute Levels Sends Mutes4 1-7 
Fader 2 Channel 2 Level Levels Sends Mutes4 1-7  Switch 2 Channel 2 Mute Levels Sends Mutes4 1-7 
Fader 3 Channel 3 Level Levels Sends Mutes4 1-7  Switch 3 Channel 3 Mute Levels Sends Mutes4 1-7 
Fader 4 Channel 4 Level Levels Sends Mutes4 1-7  Switch 4 Channel 4 Mute Levels Sends Mutes4 1-7 
Fader 5 Channel 5 Level Levels Sends Mutes4 1-7  Switch 5 Channel 5 Mute Levels Sends Mutes4 1-7 
Fader 6  Channel 6 Level Levels Sends Mutes4 1-7  Switch 6 Channel 6 Mute Levels Sends Mutes4 1-7 
Fader 7 Channel 7 Level Levels Sends Mutes4 1-7  Switch 7 Channel 7 Mute Levels Sends Mutes4 1-7 
Fader 8    Switch 8   
      
Fader 9 Channel 8 Level Levels Sends Mutes4 1-7    
Fader 10 Channel 9 Level Levels Sends Mutes4 1-7    
Fader 11 Channel 10 Level Levels Sends Mutes4 1-7    
Fader 12 Channel 11 Level Levels Sends Mutes4 1-7    
Fader 13 Channel 12 Level Levels Sends Mutes4 1-7    
Fader 14 Channel 13 Level Levels Sends Mutes4 1-7    
Fader 15 Channel 14 Level Levels Sends Mutes4 1-7    
Fader 16      
      
Fader 17 Channel 1 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 18 Channel 2 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 19  Channel 3 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 20 Channel 4 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 21 Channel 5 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 22 Channel 6 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 23 Channel 7 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 24      
      
Fader 25 Channel 8 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 26 Channel 9 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 27  Channel 10 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 28 Channel 11 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 29 Channel 12 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 30 Channel 13 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 31 Channel 14 Aux 4 Send Levels Sends Mutes4 1-7    
Fader 32      
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Subtractor 
 

 
 
 
 

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control 
Variations 

Fader 1 Filter Freq   Switch 1 Filter Link Freq On/Off  
Fader 2 Filter Res   Switch 2 Filter2 On/Off  
Fader 3 Filter2 Freq   Switch 3 Filter Env Invert  
Fader 4 Filter2 Res   Switch 4 Mod Env Invert  
      
Fader 5 Filter Env Attack   Switch 5 Osc2 On/Off  
Fader 6 Filter Env Decay   Switch 6 Osc2 Kbd Track  
Fader 7 Filter Env Sustain   Switch 7 Ring Mod  
Fader 8 Filter Env Release   Switch 8 Noise On/Off  
      
Fader 9 Filter Type SubBank1    
Fader 10 Filter Kbd Track SubBank1    
Fader 11  Filter Env Amount SubBank1    
Fader 12 Filter Env Vel Amount SubBank1    
      
Fader 13 Amp Env Attack SubBank1    
Fader 14 Amp Env Decay SubBank1    
Fader 15  Amp Env Sustain SubBank1    
Fader 16 Amp Env Release SubBank1    
      
Fader 9 LFO1 Rate SubBank2  
Fader 10 LFO1 Amount SubBank2  
Fader 11  LFO1 Wave SubBank2  
Fader 12 LFO1 Dest SubBank2  
    
Fader 13 LFO2 Rate SubBank2  
Fader 14 LFO2 Amount SubBank2  
Fader 15  LFO2 Wave SubBank2  
Fader 16 LFO2 Dest SubBank2  
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Thor 
 
MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control 
Variations 

Fader 1 Filter 1 Freq   Switch 1 Osc 1 To Filter 1 Enable  
Fader 2 Filter 1 Res   Switch 2 Osc 2 To Filter 1 Enable  
Fader 3 Filter 2 Freq   Switch 3 Osc 3 To Filter 1 Enable  
Fader 4 Filter 2 Res   Switch 4 Osc 1 To Filter 2 Enable  
      
Fader 5 Filter Env Attack   Switch 5 Osc 2 Sync To Osc 1  
Fader 6 Filter Env Decay   Switch 6 Osc 3 Sync To Osc 1  
Fader 7 Filter Env Sustain   Switch 7 Delay On  
Fader 8 Filter Env Release   Switch 8 Delay Sync  
      
Fader 9 Filter 1 Env Amount ThorBank1     
Fader 10 Filter 1 Drive ThorBank1    
Fader 11  Filter 2 Env Amount ThorBank1    
Fader 12 Filter 2 Drive ThorBank1    
      
Fader 13 Global Env Attack ThorBank1    
Fader 14 Global Env Decay ThorBank1    
Fader 15  Global Env Sustain ThorBank1    
Fader 16 Global Env Release ThorBank1    
    
Fader 9 Osc 1 Mod ThorBank2  
Fader 10 Osc 2 Mod ThorBank2  
Fader 11  Osc 3 Mod ThorBank2  
Fader 12 Osc 1 AM From Osc 2 ThorBank2  
    
Fader 13 Delay Time ThorBank2  
Fader 14 Delay Feedback ThorBank2  
Fader 15  Delay Rate ThorBank2  
Fader 16 Delay Amount ThorBank2  



 

16 

 
Malström 
 
MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control 
Variations 

Fader 1 Filter A Freq    Switch 1 Filter A On/Off  
Fader 2 Filter A Resonance   Switch 2 Filter A Env  
Fader 3 Filter B Freq   Switch 3 Filter B On/Off  
Fader 4 Filter B Resonance   Switch 4 Filter B Env  
      
Fader 5 Filter Env Attack   Switch 5 Oscillator A On/Off  
Fader 6 Filter Env Decay   Switch 6 Route Oscillator A To Shaper  
Fader 7 Filter Env Sustain   Switch 7 Route Oscillator A To Filter B  
Fader 8 Filter Env Release   Switch 8 Oscillator B On/Off  
      
Fader 9 Filter Env Amount MalBank1  Switch 9 Modulator A On/Off  
Fader 10 Filter A Mode MalBank1  Switch 10 Modulator B On/Off  
Fader 11  Filter B Mode MalBank1  Switch 11 Modulator A Sync  
Fader 12 Shaper Mode MalBank1  Switch 12 Modulator B On/Off  
      
Fader 9 Modulator A Rate  MalBank2  Switch 13 Modulator A On/Off  
Fader 10 Modulator A To Pitch MalBank2  Switch 14 Modulator A One Shot  
Fader 11  Modulator A To Index MalBank2  Switch 15 Modulator A Sync  
Fader 12 Modulator A To Shift MalBank2  Switch 16 Modulator B On/Off  
      
Fader 13 Oscillator A Motion MalBank1    
Fader 14 Oscillator A Shift MalBank1    
Fader 15  Oscillator A Octave MalBank1    
Fader 16 Oscillator A Gain MalBank1    
      
Fader 13 Modulator A Curve MalBank2    
Fader 14 Modulator A Target MalBank2    
Fader 15 Modulator B Curve MalBank2    
Fader 16 Modulator B Target MalBank2    
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NN19 Sampler 
 

 
 

NN-XT Advanced Sampler 
 

 

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control 
Variations 

Fader 1 Filter Freq   Switch 1 Filter On/Off  
Fader 2 Filter Res   Switch 2 Filter Env Invert  
Fader 3 Filter Kbd Track   Switch 3 Sample  
Fader 4 Filter Env Amount   Switch 4   
      
Fader 5 Osc Octave   Switch 5   
Fader 6 Osc Semitone   Switch 6   
Fader 7 Osc Fine Tune   Switch 7   
Fader 8 Osc Env Amount   Switch 8   
      
Fader 9 Filter Mode NN19Bank1    
Fader 10 Filter Freq Ext Mod NN19Bank1    
Fader 11  LFO Ext Mod NN19Bank1    
Fader 12 Amp Ext Mod NN19Bank1    
      
Fader 9 Filter Env Vel Amount NN19Bank2    
Fader 10 Filter Decay Vel Amount NN19Bank2    
Fader 11  Amp Vel Amount NN19Bank2    
Fader 12 Amp Attack Vel Amount NN19Bank2    
   

Fader 13 LFO Rate NN19Bank1  
Fader 14 LFO Amount NN19Bank1  
Fader 15  LFO Wave NN19Bank1  
Fader 16 LFO Dest NN19Bank1  
    
Fader 13 Filter Freq Mod Wheel Amount NN19Bank2  
Fader 14 Filter Res Mod Wheel Amount NN19Bank2  
Fader 15  Filter Decay Mod Wheel Amount NN19Bank2  
Fader 16 Amp  Mod Wheel Amount NN19Bank2  

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control 
Variations 

Fader 1 Filter Freq   Fader 17 Drum 3 Send NN-XTSend 
Fader 2 Filter Res   Fader 18 Drum 4 Send NN-XTSend 
Fader 3 Amp Env Attack   Fader 19 Drum 5 Send NN-XTSend 
Fader 4 Amp Env Decay   Fader 20 Drum 6 Send NN-XTSend 
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Redrum Drum Computer 
 

 

 

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason 
Function 

Control 
Variations 

Fader 1 Drum 1 Level Level Pan 1-4  Fader 9 Drum 9 Pitch Level Pan 9-10 

Fader 2 Drum 2 Level Level Pan 1-4  Fader 10 Drum 10 Pitch Level Pan 9-10 

Fader 3 Drum 3 Level Level Pan 1-4  Fader 11   

Fader 4 Drum 4 Level Level Pan 1-4  Fader 12   

       

Fader 1 Drum 5 Level Level Pan 5-8  Fader 13 Drum 1 Send Level Pan 1-4 

Fader 2 Drum 6 Level Level Pan 5-8  Fader 14 Drum 2 Send Level Pan 1-4 

Fader 3 Drum 7 Level Level Pan 5-8  Fader 15 Drum 3 Send Level Pan 1-4 

Fader 4 Drum 8 Level Level Pan 5-8  Fader 16 Drum 4 Send Level Pan 1-4 

       

Fader 1 Drum 9 Level Level Pan 9-10  Fader 13 Drum 5 Send Level Pan 5-8 

Fader 2 Drum 10 Level Level Pan 9-10  Fader 14 Drum 6 Send Level Pan 5-8 

Fader 3    Fader 15 Drum 7 Send Level Pan 5-8

Fader 4    Fader 16 Drum 8 Send Level Pan 5-8 

       

Fader 5 Drum 1 Pan Level Pan 1-4  Fader 13 Drum 9 Send Level Pan 9-10 

Fader 6 Drum 2 Pan Level Pan 1-4  Fader 14 Drum 10 Send Level Pan 9-10 

Fader 7 Drum 3 Pan Level Pan 1-4  Fader 15  

Fader 8 Drum 4 Pan Level Pan 1-4  Fader 16  

       

Fader 5 Drum 5 Pan Level Pan 5-8  Pad D1 Bank A  

Fader 6 Drum 6 Pan Level Pan 5-8  Pad D2 Bank B  

Fader 7 Drum 7 Pan Level Pan 5-8  Pad D3 Bank C 

Fader 8 Drum 8 Pan Level Pan 5-8  Pad D4 Bank D  

Fader 5 Drum 9 Pan Level Pan 9-10  Pad D5 Pattern 1  

Fader 6 Drum 10 Pan Level Pan 9-10  Pad D6 Pattern 2  

Fader 7    Pad D7 Pattern 3  

Fader 8    Pad D8 Pattern 4  

       

Fader 9 Drum 1 Pitch Level Pan 1-4     

Fader 10 Drum 2 Pitch Level Pan 1-4     

Fader 11 Drum 3 Pitch Level Pan 1-4     

Fader 12 Drum 4 Pitch Level Pan 1-4     

       

Fader 9 Drum 5 Pitch Level Pan 5-8     

Fader 10 Drum 6 Pitch Level Pan 5-8     

Fader 11 Drum 7 Pitch Level Pan 5-8     

Fader 12 Drum 8 Pitch Level Pan 5-8     
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Kong Drum Designer 
 

 
RV7000 Advanced Reverb 
 

 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Drum 1 Level  Switch 1  
Fader 2 Drum 2 Level  Switch 2  
Fader 3 Drum 3 Level  Switch 3 Quick Sample 
Fader 4 Drum 4 Level  Switch 4  
    
Fader 5 Drum 5 Level  Switch 5 Select Previous Patch 
Fader 6  Drum 6 Level  Switch 6 Select Next Patch 
Fader 7 Drum 7 Level  Switch 7  
Fader 8 Drum 8 Level  Switch 8  
    
Fader 9 Drum 9 Level   
Fader 10 Drum 10 Level   
Fader 11 Drum 11 Level   
Fader 12 Drum 12 Level   
    
Fader 13 Drum 13 Level   
Fader 14 Drum 14 Level   
Fader 15 Drum 15 Level   
Fader 16 Drum 16 Level   

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Decay  Switch 1 EQ On/Off 
Fader 2 HF Damp  Switch 2 Gate On/Off 
Fader 3 Hi EQ  Switch 3  
Fader 4 Dry/Wet  Switch 4  
    
Fader 5 Soft Knob 1   
Fader 6 Soft Knob 2   
Fader 7 Soft Knob 3   
Fader 8 Soft Knob 4   
    
Fader 9 Soft Knob 5   
Fader 10 Soft Knob 6   
Fader 11 Soft Knob 7   
Fader 12 Soft Knob 8   
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Scream 4 Distortion 
  

 
BV512 Digital Vocoder 
 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Damage Control  Switch 1 Damage On/Off 
Fader 2 Damage Type  Switch 2 Cut On/Off 
Fader 3 Parameter 1  Switch 3 Body On/Off 
Fader 4 Parameter 2  Switch 4  
    
Fader 5 Cut Lo   
Fader 6  Cut Mid   
Fader 7 Cut Hi   
Fader 8 Master Level   
    
Fader 9 Body Resonance   
Fader 10 Body Scale   
Fader 11 Body Auto   
Fader 12 Body Type   

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control 
Variations 

Fader 1 Band Count Parm  Switch 1 Vocoder/Equalizer  
Fader 2 Shift Parm  Switch 2 Hold  
Fader 3 Attack Parm    
Fader 4 Decay Parm    
      
Fader 5 HF Emphasis Parm    
Fader 6  Dry/Wet Parm    
Fader 7  Parm    
Fader 8  Parm    
      
Fader 1 Band Level 1 Band     
Fader 2 Band Level 2 Band     
Fader 3 Band Level 3 Band     
Fader 4 Band Level 4 Band     
      
Fader 5 Band Level 5 Band     
Fader 6  Band Level 6 Band     
Fader 7 Band Level 7  Band     
Fader 8 Band Level 8  Band     
      
Fader 9 Band Level 9 Band     
Fader 10 Band Level 10 Band     
Fader 11 Band Level 11 Band     
Fader 12 Band Level 12 Band     
      
Fader 13 Band Level 13 Band     
Fader 14 Band Level 14 Band     
Fader 15 Band Level 15 Band     
Fader 16 Band Level 16 Band     
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Neptune Pitch Adjuster 
 

 
MClass Equalizer 
 

 
MClass Stereo Imager 
 

 
MClass Compressor 
 

 

MAX25 Control Reason Function MAX25 Control Reason Function
Switch 1 Pitch Adjust On/Off  Fader 1 Correction Speed 
Switch 2 Scale Memory  Fader 2 Preserve Expression 
Switch 3 Transpose On/Off  Fader 3 Semitones 
Switch 4 MIDI Destination  Fader 4 Cent 
    
Switch 5 Formant On/Off  Fader 5 Formant Shift 
Switch 6  Enabled  Fader 6 Vibrato Rate 
   Fader 7 Pitch Bend Range 
   Fader 8 Pitched Signal Level 
    
   Fader 9 Voice Synth Level 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Low Shelf Gain  Switch 1 Low Cut Enable 
Fader 2 Parametric 1 Gain  Switch 2 Low Shelf Enable 
Fader 3 Parametric 2 Gain  Switch 3 Parametric 1 Enable 
Fader 4 Hi Shelf Gain  Switch 4 Parametric 2 Enable 
    
Fader 5 Low Shelf Q  Switch 5 Hi Shelf Enable 
Fader 6  Parametric 1 Q   
Fader 7 Parametric 2 Q   
Fader 8 Hi Shelf Q   
    
Fader 9 Low Shelf Frequency   
Fader 10 Parametric 1 Frequency   
Fader 11 Parametric 2 Frequency   
Fader 12 Hi Shelf Frequency   

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Low Width  Switch 1 Low Band Active 
Fader 2 X-Over Frequency  Switch 2 High Band Active 
Fader 3 High Width  Switch 3 Separate Out Mode 
Fader 4 Solo Mode   

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Input Gain  Switch 1 Soft Knee 
Fader 2 Threshold  Switch 2 Sidechain Solo 
Fader 3 Ratio  Switch 3 Adapt 
Fader 4 Attack  Switch 4 Sidechain Active 
    
Fader 5 Release   
Fader 6  Output Gain   
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MClass Maximizer 
 

 
RV-7 Digital Reverb 
 

 
DDL-1 Digital Delay Line 
 

 
D-11 Foldback Distortion 
 

 
ECF-42 Envelope Control Filter 
 

 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Input Gain  Switch 1 Limiter Enable 
Fader 2 Attack Speed  Switch 2 Look Ahead Enable 
Fader 3 Release Speed  Switch 3 Soft Clip Enable 
Fader 4 Output Gain  Switch 4 Output Level Meter Mode 
    
Fader 5 Soft Clip Amount   

MAX25 Control Reason Function  
Fader 1 Algorithm   
Fader 2 Size   
Fader 3 Decay   
Fader 4 Damping   
    
Fader 5 Dry/Wet   

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 DelayTime (steps)  Switch 1 Unit 
Fader 2 DelayTime (ms)  Switch 2 Step Length 
Fader 3 Feedback   
Fader 4 Pan   
    
Fader 5 Dry/Wet Balance   

MAX25 Control Reason Function  
Fader 1 Amount   
Fader 2 Foldback   

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Frequency  Switch 1 Trigger 
Fader 2 Resonance   
Fader 3 Env Amount   
Fader 4 Velocity   
    
Fader 5 Mode   
Fader 6  Attack   
Fader 7 Decay   
Fader 8 Sustain   
    
Fader 9 Release   
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CF-101 Chorus/Flanger 
 

 
PH-90 Phaser 
 

 
UN-16 Unison 
 

 
COMP-01 Compressor/Limiter 
 

 
PEQ-2 Two-Band Parametric EQ 
 

 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Delay  Switch 1 LFO Sync Enable 
Fader 2 Feedback  Switch 2 Send/Insert Mode 
Fader 3 Rate   
Fader 4 Modulation Amount   

MAX25 Control Reason Function  MAX25 Control Reason Function 
Fader 1 Frequency  Switch 1 LFO Sync Enable 
Fader 2 Split   
Fader 3 Width   
Fader 4 Rate   
    
Fader 5 Frequency Modulation   
Fader 6  Feedback   

MAX25 Control Reason Function  
Fader 1 Voice Count  

Fader 2 Detune  

Fader 3 Dry/Wet  

MAX25 Control Reason Function  
Fader 1 Ratio  

Fader 2 Threshold  

Fader 3 Attack  

Fader 4 Release  

   

Fader 5 Gain  

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Filter A Freq  Switch 1 Filter B On/Off 
Fader 2 Filter A Q   
Fader 3 Filter A Gain   
Fader 4 Filter B Freq   
    
Fader 5 Filter B Q   
Fader 6  Filter B Gain   
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Matrix Pattern Sequencer 
 

 
RPG-8 Monophonic Arpeggiator 
 

 

MAX25 Control Reason Function MAX25 Control Reason Function
Pad 1 Bank A  Fader 1 Pattern Select in Bank 
Pad 2 Bank B  Fader 2 Bank Select 
Pad 3 Bank C  Fader 3 Resolution 
Pad 4 Bank D   
   Switch 1 Run 
Pad 5 Pattern 1  Switch 2 Pattern Enable 
Pad 6 Pattern 2   
Pad 7 Pattern 3   
Pad 8 Pattern 4   

MAX25 Control Reason Function MAX25 Control Reason Function
Switch 1 Hold  Fader 1 Velocity/Manual 
Switch 2 Arpeggiator Enable  Fader 2 Mode 
Switch 3 Single Note Repeat  Fader 3 Octave 
Switch 4 Shuffle  Fader 4 Insert 
    
Switch 5 Pattern Step 1  Fader 5 Rate 
Switch 6  Pattern Step 2  Fader 6 Gate Length 
Switch 7 Pattern Step 3   
Switch 8 Pattern Step 4   
    
Switch 9 Pattern Step 5   
Switch 10 Pattern Step 6   
Switch 11 Pattern Step 7   
Switch 12 Pattern Step 8   
    
Switch 13 Pattern Step 9   
Switch 14 Pattern Step 10   
Switch 15 Pattern Step 11   
Switch 16 Pattern Step 12   
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Regroove Mixer 
 

 
ID8 Instrument Device 
 

 

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control 
Variations 

Fader 1 A1 Groove Amount   Fader 9 A1 Slide Slide 
Fader 2 A2 Groove Amount   Fader 10 A2 Slide Slide 
Fader 3 A3 Groove Amount   Fader 11 A3 Slide Slide 
Fader 4 A4 Groove Amount   Fader 12 A4 Slide Slide 
      
Fader 5 A5 Groove Amount   Fader 13 A5 Slide Slide 
Fader 6  A6 Groove Amount   Fader 14 A6 Slide Slide 
Fader 7 A7 Groove Amount   Fader 15 A7 Slide Slide 
Fader 8 A8 Groove Amount   Fader 16 A8 Slide Slide 
      
Fader 9 A1 Shuffle Shuffle    
Fader 10 A2 Shuffle Shuffle    
Fader 11 A3 Shuffle Shuffle    
Fader 12 A4 Shuffle Shuffle    
      
Fader 13 A5 Shuffle Shuffle    
Fader 14 A6 Shuffle Shuffle    
Fader 15 A7 Shuffle Shuffle    
Fader 16 A8 Shuffle Shuffle    

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Parameter 1  Switch 1  
Fader 2 Parameter 2  Switch 2  
Fader 3   Switch 3  
Fader 4   Switch 4  
    
Fader 5   Switch 5  
Fader 6    Switch 6  
Fader 7   Switch 7 Select Previous Preset 
Fader 8 Volume  Switch 8 Select Next Preset 
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Line 6 Guitar Amp 
 

 
Line 6 Bass Amp 
 

 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Volume Pedal  Switch 1 Wah Pedal On 
Fader 2 Bass  Switch 2  
Fader 3 Middle  Switch 3  
Fader 4 Treble  Switch 4  
    
Fader 5 Drive  Switch 5 Select Previous Amp Model 
Fader 6  Presence  Switch 6 Select Next Amp Model 
Fader 7 Volume  Switch 7 Select Previous Cab Model 
Fader 8   Switch 8 Select Next Cab Model 
    
Expression Wah Pedal  Switch 9  
   Switch 10  
   Switch 11 Select Previous Patch 
   Switch 12 Select Next Patch 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Comp Threshold  Switch 1 Compressor On 
Fader 2 Drive  Switch 2  
Fader 3   Switch 3  
Fader 4 Volume  Switch 4  
    
Fader 5 Bass  Switch 5 Select Previous Amp Model 
Fader 6  Lo Mid  Switch 6 Select Next Amp Model 
Fader 7 Hi Mid  Switch 7 Select Previous Cab Model 
Fader 8 Treble  Switch 8 Select Next Cab Model 
    
   Switch 9  
   Switch 10  
   Switch 11 Select Previous Patch 
   Switch 12 Select Next Patch 
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Reason Record Main Mixer Channel 
 
MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control
Variations 

Fader 1 Level   Switch 1 Mute  

Fader 2 Pan   Switch 2 Solo  
Fader 3 Width   Switch 3 Switch 1  
Fader 4    Switch 4 Switch 2  
       
Fader 5 Rotary 1   Switch 5 Switch 3  
Fader 6  Rotary 2   Switch 6  Switch 4  
Fader 7 Rotary 3   Switch 7 EQ On   

Fader 8 Rotary 4   Switch 8 EQ E Mode  

       

Fader 9 FX1 Send Level Send1-8  Switch 9 FX1 Send On  

Fader 10 FX2 Send Level Send1-8  Switch 10 FX2 Send On  

Fader 11 FX3 Send Level Send1-8  Switch 11 FX3 Send On  

Fader 12 FX4 Send Level Send1-8  Switch 12 FX4 Send On  

       

Fader 13 FX5 Send Level Send1-8  Switch 13 FX5 Send On  

Fader 14 FX6 Send Level Send1-8  Switch 14 FX6 Send On  

Fader 15 FX7 Send Level Send1-8  Switch 15 FX7 Send On  

Fader 16 FX8 Send Level Send1-8  Switch 16 FX8 Send On  
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Reason Record Master Section 
 

 
Reason Record Global Controls 
 

 

MAX25 
Control 

Reason 
Function 

Control 
Variations  MAX25 

Control 
Reason
Function 

Control
Variations

Fader 1 Channel 1 Level   Switch 1 Previous 8 Remote Base Channel

Fader 2 Channel 2 Level   Switch 2 Next 8 Remote Base Channel 

Fader 3 Channel 3 Level   Switch 3 Bypass Insert FX 

Fader 4 Channel 4 Level   Switch 4   

       

Fader 5 Channel 1 Pan Main  Switch 5 Switch 1  

Fader 6 Channel 2 Pan  Main  Switch 6  Switch 2  

Fader 7 Channel 3 Pan Main  Switch 7 Switch 3   

Fader 8 Channel 3 Pan Main  Switch 8 Switch 4  

       

Fader 5 FX1 Pan FX  Switch 9 FX1 Mute  

Fader 6 FX2 Pan FX  Switch 10 FX2 Mute  

Fader 7  FX3 Pan FX  Switch 11 FX3 Mute  

Fader 8 FX4 Pan FX  Switch 12 FX4 Mute  

       

Fader 9 FX1 Return Level    Switch 13 FX5 Mute  

Fader 10 FX2 Return Level    Switch 14 FX6 Mute  

Fader 11  FX3 Return Level   Switch 15 FX7 Mute  

Fader 12 FX4 Return Level   Switch 16 FX8 Mute  

       

Fader 13 Rotary 1 Main     

Fader 14 Rotary 2 Main     

Fader 15 Rotary 3 Main     

Fader 16 Master Level Main     

       

Fader 13 Compress On FX     

Fader 14 Threshold FX     

Fader 15 Ratio FX     

Fader 16 Attack FX     

MAX25 Control Reason Function  MAX25 Control Reason Function 
Stop Stop  Switch 15 Select Prev Patch for Target Device 

Play Play  Switch 16 Select Next Patch for Target Device 

Record Record  Switch 7 Target Previous Track 

Rewind Rewind  Switch 8 Target Next Track 

Fast Forward Fast Forward  Switch 23 Select Previous Keyboard Shortcut Variation 

Stop Stop  Switch 24 Select Next Keyboard Shortcut Variation 
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Reason Essentials Main Mixer Channel 
 

 
 
 

MAX25 Control Reason Function MAX25 Control Reason Function
Fader 1 Level  Switch 1 Mute 
Fader 2 Pan  Switch 2 Solo 
Fader 3 Width  Switch 3 Switch 1 
Fader 4   Switch 4 Switch 2 
    
Fader 5 Rotary 1  Switch 5 Switch 3 
Fader 6  Rotary 2  Switch 6 Switch 4 
Fader 7 Rotary 3  Switch 7 EQ On 
Fader 8 Rotary 4  Switch 8 LF Bell 
    
Fader 9 LF Gain  Switch 17 FX1 Send On
Fader 10 LF Frequency  Switch 18 FX2 Send On
Fader 11 HF Gain  Switch 19 FX3 Send On 
Fader 12 HF Frequency  Switch 20 FX4 Send On 
    
Fader 13 FX1 Send Level  Switch 21 FX1 Pre Fader 
Fader 14 FX2 Send Level  Switch 22 FX2 Pre Fader
Fader 15 FX3 Send Level  Switch 23 FX3 Pre Fader
Fader 16 FX4 Send Level  Switch 24 FX4 Pre Fader
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Steinberg Cubase 
 

Setup 
 
1. Connect MAX25 to your computer with the included USB cable. Open Cubase. 

2. On MAX25, select the Cubase or CubaseKS Program. Press the Value Dial to load it. 

Note: If you have edited MAX25's Programs and are unable to load the Program, use the 
supplied Vyzex editor to load the Factory Preset Bank and "PUT" or download the factory 
preset bank into MAX25. 

3. In Cubase, click Devices in the menu bar, and select Device Setup.  

4. In the Device Setup window's upper left corner, click the + symbol, and select Mackie 
Control. 

5. In the upper right part of the window, click each drop-down menu next to MIDI Input and MIDI 
Output, and select MIDIIN4 (Akai MAX25) (Windows 7, Windows Vista) or USB Audio 
Device [4] (Windows XP). 

6. Click OK.  
 
IMPORTANT!: To use MAX25's transport controls (Play, Stop, Record, etc.) in Cubase, follow these 
additional steps: 

1. Press [EDIT] on MAX25. 

2. Press any one of MAX25's transport controls. 

3. Turn the Value Dial until the Type is set to Mackie. You may now use the transport controls in 
Cubase. 
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Program Operation 
 
Cubase 
 
When using MAX25's Cubase Program, the controls' behavior is as follows: 
 
Transport Controls (Play, Stop, Rec, etc.): When these controls are set to Mackie, they will work 
accordingly in the software. See the note in the Setup section above. 
 
Bank 1-4:  

• Touch faders: These control the volume level of Tracks 1-4.  

• S-switches: These record-arm Tracks 1-4. 
 
Bank 5-8:  

• Touch faders: These control the volume level of Tracks 5-8.  

• S-switches: These record-arm Tracks 5-8. 
 
Bank 9-12:  

• Touch faders: These control the panning of Tracks 1-4. 

• S-switches: These mute Tracks 1-4. 
 
Bank 13-16:  

• Touch faders: These control the panning of Tracks 5-8. 

• S-switches: These mute Tracks 5-8. 
 
CubaseKS 
 
This Program is almost the same as the Cubase Program described above, but this version allows 
you to turn MAX25's Sequencer on/off by pressing keys on its keyboard. To do this: 
 
1. Press SEQ SELECT so it is lit. 

2. Press ON/OFF so it is lit. 

3. Press and hold a key on MAX25's keyboard. The Sequence will play (in that key) while the key 
is being held. When you release the key, the Sequence will stop.  

Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, 
Sequencer playback will continue even after the key is released.) 
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Apple Logic Pro 
 

Setup 
 
You can use MAX25 with Logic Pro 8 or higher. MAX25's Mackie Control protocol allows it to act as a 
control surface for the DAW. To do this: 
 
1. Connect MAX25 to your computer with the included USB cable. Open Logic Pro. 

2. On MAX25, select the Mackie Control Program. Press the Value Dial to load it. 

3. In Logic Pro, click the Logic Pro menu, then select Preferences  MIDI. 

4. In the window that appears, select the Control Surfaces page, and click Setup in the lower 
right corner. 

5. In the window that appears, click New, and select Install. 

6. From the list that appears, select the device that lists Mackie Designs as the Manufacturer 
and Mackie Control as the Model. 

7. Click Add in the lower right corner of the window, then close the window. Do not click Scan. 

8. Select Mackie as the Out Port and Input. 

9. Close all the Preferences window. 
 

Program Operation 
 
When using MAX25's Logic Program, the controls' behavior is as follows: 
 
Bank 1-4:  

• Touch faders: These control the volume level of Tracks 1-4.  

• S-switches: These record-arm Tracks 1-4. 
 
Bank 5-8:  

• Touch faders: These control the volume level of Tracks 5-8.  

• S-switches: These record-arm Tracks 5-8. 
 
Bank 9-12:  

• Touch faders: These control the panning of Tracks 1-4. 

• S-switches: These mute Tracks 1-4. 
 
Bank 13-16:  

• Touch faders: These control the panning of Tracks 5-8. 

• S-switches: These mute Tracks 5-8.
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Image-Line FL Studio 
 

Setup 
 
1. Download the FL Studio controller map to your computer from the included CD or from 

www.akaipro.com/max25. 
 
2. With FL Studio closed, copy the entire MAX25 folder (the folder itself, not just its contents) to 

the following location in your computer: C:\Program Files\Image-Line\FL Studio 
[version]\Data\Projects\Templates\Hardware. 

 
3. Connect MAX25 to your computer with the included USB cable. Open FL Studio. 
 
4. On MAX25, select the FLStudio or FLStudKS Program. Press the Value Dial to load it. 

 
Note: If you have edited MAX25's Programs and are unable to load the Program, use the 
supplied Vyzex editor to load the Factory Preset Bank and "PUT" or download the factory 
preset bank into MAX25. 

 
5. Press F10, or go to Options  MIDI Settings. 
 
6. Under Output, select MAX25 (Windows 7, Windows Vista) or USB Audio Device (Windows 

XP), and check the Send master sync box. 
 
7. Under Input, select MAX25 (Windows 7, Windows Vista) or USB Audio Device (Windows 

XP), and check the Enable box. 
 
8. For Omni preview MIDI channel, select Channel 16. 
 
9. For Generator muting MIDI channel, select Channel 15. 
 
10. Check the Record to step sequencer box. 
 
MAX25's FL Studio Program is configured to use FL Studio's step sequencer. For working with the 
Piano Roll, use one of the Akai MPK's generic templates. 
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Program Operation 
 
FLStudio 
 
MAX25's FL Studio Program has a sampler channel dedicated to each pad: 

• Pad Bank A: Plays each channel at its true pitch. 

• Pad Bank B: Mutes the corresponding pad. 

• Pad Bank C: Selects the corresponding channel, allowing for each channel to be played 
chromatically with MAX25's keyboard. 

• Pad Bank D: Plays the sample loaded on the selected track in semitones. 
 
MAX25's S-switches and faders are available to be mapped within FL Studio to whatever is desired.  
 
FLStudKS 
 
This Program is almost the same as the FL Studio Program described above, but this version allows 
you to turn MAX25's Sequencer on/off by pressing keys on its keyboard. To do this: 
 
1. Press SEQ SELECT so it is lit. 

2. Press ON/OFF so it is lit. 

3. Press and hold a key on MAX25's keyboard. The Sequence will play (in that key) while the key is 
being held. When you release the key, the Sequence will stop.  

Note: (To "latch" the Sequencer, press [LATCH] so it is lit. When this button is activated, 
Sequencer playback will continue even after the key is released.) 
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Avid Pro Tools 
 

Setup 
 
You can use MAX25 as a control surface for Pro Tools. To do this: 
 
1. Connect MAX25 to your computer with the included USB cable. Open Pro Tools. 

2. On MAX25, select the Pro Tools or Pro Tools KS program. Press the Value Dial to load it. 

3. In Pro Tools, go to Setup  Peripherals, and select the MIDI Controllers tab. 

4. Select HUI as the #1 Type. 

5. Select AkaiMAX25 Mackie as the #1 Receive From and #1 Send To. 
 

Program Operation 
 
When using MAX25's Pro Tools Program, the controls' behavior is as follows: 
 
Bank 1-4:  

• Touch faders: These control the volume level of Tracks 1-4.  

• S-switches: These record-arm Tracks 1-4. 
 
Bank 5-8:  

• Touch faders: These control the volume level of Tracks 5-8.  

• S-switches: These record-arm Tracks 5-8. 
 
Bank 9-12:  

• Touch faders: These control the panning of Tracks 1-4. 

• S-switches: These mute Tracks 1-4. 
 
Bank 13-16:  

• Touch faders: These control the panning of Tracks 5-8. 

• S-switches: These mute Tracks 5-8. 
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Avid Pro Tools Express 
 

Setup 
 
1. Connect MAX25 to your computer with the included USB cable. Open Pro Tools Express. 

2. On MAX25, select the PTEX Program. Press the Value Dial to load it. 

3. Open Pro Tools Express. 

4. In Pro Tools Express, go to the Peripherals window and select the following settings under 
MIDI Controllers: 

• Type: Select the MAX25 option or a generic option for an Akai Professional keyboard 
controller. If neither option is available, select the M-Audio keyboard option (MAdKybr). 

• Receive From: Select Akai MAX25 Port 2. 

• Send To: Select Akai MAX25 Port 2. 

• # Ch's: Select 8. 
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Trademarks and Licenses 
 
Ableton is a trademark of Ableton AG. 

Reason is a trademark of Propellerhead Software.  

Cubase is a trademark of Steinberg Media Technologies GmbH.  

Logic, Logic Pro, and Mac are trademarks of Apple Inc., registered in the U.S. and other countries. 

FL Studio is a trademark of Image Line Software BVBA. 

Avid and Pro Tools are trademarks or registered trademarks of Avid Technology, Inc. in the U.S. and 
other countries. 

Pro Tools Express © 2012 Avid Technology, Inc. All rights reserved. Use of Pro Tools Express is 
subject to a related license agreement.  

Mackie Control and HUI are trademarks or registered trademarks of LOUD Technologies Inc. 

Windows, Windows XP, Windows Vista, and Windows 7 are registered trademarks of Microsoft 
Corporation in the United States and other countries. 

 
All other trademarks contained herein are the property of their respective owners. 
 
Product features, specifications, system requirements, and availability are subject to change without 
notice.
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